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Introduction

Active Mail is a mail account management and download application. The application allows you to slash communications costs by scheduling mail
related activities to be executed at off-peak hours. It also makes the management of your email accounts effortless through features such as mail
download management and mail folder synchronisation.

Active Mail also allows you to retrieve and respond immediately to urgent emails through the Notifications Manager. Urgent emails can also be written and
sent immediately using the m-Mail editor which supports the sending of emails via the SMS communications protocol.

Active Mail Components
Active Mail is made up of four key components:
1. Mail account management and synchronisation

This component is the main interactive component of the package. It allows you to manage your mail accounts efficiently by marking headers of
messages to be downloaded, or mail folders to be synchronised. Synchronised folders automatically have the full message bodies downloaded for
messages which match configurable criteria. These operations can then be processed interactively through the Active Mail interface, or can be
scheduled to take place at any time (e.g. during off-peak hours when communications costs are minimised).

This component can also be used to download mail for multiple accounts at one press of a button.
2. Active Mail Scheduler

The Active Mail scheduler is the engine behind the application which allows virtually all mail operations to take place in unattended mode, allowing
for costly mail downloads to take place at off-peak hours.

3. Active Mail Notifications Manager

The Notifications manager allows you to set up rules on how to process new mail notifications that arrive via SMS. Active Mail can be configured
to automatically respond to an SMS notification, connect to the corresponding email account and download any new mails from that service.

4. m-Malil editor.

The m-Mail editor is a cost and time efficient mechanism for send emails quickly and cheaply — perfect for those urgent emails. It has a familiar
interface and allows emails to be sent over the SMS communications protocol, thus removing the need to even connect to an ISP.

See Apprendix A for a description of how all the various rules and options described in this document work together.
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General Settings and Commands

Active Mail has a number of general settings and commands that affect the overall behaviour of the application.

Invoking Active Mail through the Messaging application button:

Active Mail can be invoked through the Messaging application button. Active Mail is configured to be the secondary application attached to this
button. This means that pressing the button once will invoke the built-in Messaging application as normal. If the button is pressed again when
Messaging is in the foreground, Active Mail will be brought to the foreground.

Write message (Ctrl+N):
This command presents a dialog offering to the user the various message types which can be created.
Close (Ctrl+E):
Active Mail can be closed by using the menu item File=»Close or using the Ctrl+E hotkey.
Add to Desk:
A link to the Active Mail application can be added to Nokia 9200 Desk by selecting File=» Add to Desk from the Active Mail menu bar.
Zoom in & Zoom out:

The size of text used in the Active Mail display can be changed by using the commands View=»Zoom in and View=>»Zoom out. The standard Nokia
9200 zoom buttons can also be used.

Go to Messaging (Ctrl+G):

This command switches to the built-in Messaging application. The Messaging application will be opened in the same folder as is currently selected
in Active Mail.

Autostart at reset:
Select this option in the Tools menu to have Active Mail automatically start when the device is reset.
Log (Shift+Ctrl+L):

The Nokia Communicator’s log application can be invoked by selecting Tools=»Log from the menu, or by using the hotkey Shift+Ctrl+L.
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Receive via infrared:
Infrared reception can be activated through Tools=»Receive via infrared... from the menu, or by using the standard Chr+: shortcut.
Help (Ctrl+H):

Context sensitive help on using Active Mail is available via the menu by using the command Info=»Help from the menu bar or the Ctrl+H hotkey.
The standard Nokia 9200 help button can also be used.

Help is provided on each on the commands available on each of the modules, the various dialogs, and the settings options available to configure
Active Malil.

About Active Mail:
A standard About dialog is available via the menu by using the command Info=»About...
Register:

If the application has not been registered, a registration dialog can be invoked via the menu by using the command Info=»Register
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Mail Account Management and Synchronisation

This component is the main interactive component of the package. It is based around a browser interface allowing you to view all mail folders and the
headers of all messages which have not been fully downloaded.

The interface allows you to manage your mail accounts efficiently by marking the headers of messages to be downloaded, or mail folders to be
synchronised. Synchronised folders automatically have the full message bodies downloaded for messages which match configurable criteria. These
operations can then be processed interactively through the Active Malil interface, or can be scheduled to take place at any time (e.g. during off-peak hours
when communications costs are minimised).

This component can also be used to download mail for multiple accounts at one press of a button.

Active Mail provides support for advanced downloading rules. This feature helps you manage your e-mail by using rules to automatically perform actions
on messages. After you create a rule, Active Mail applies the rule when messages arrive in your Inbox. Using these rules it is possible to either delete or
download the full message based on criteria such as Sender Address or Subject. For example, you can automatically download full messages based on
the subject line, or automatically delete emails based on the sender address.

Synchronising mail folders

Mail folders are marked for synchronisation by selecting the mail folder and either using the Mark folder for sync command button or using the menu
command Synchronise->Synchronise folder. The folder icon then takes on the synchronisation arrows to indicate that it is to be synchronised.
Synchronisation can be cancelled by selecting the folder and using the same commands. See the screen shot below

g" Aciivedilar l MBA I to dewerdoad 0 marked) Open folder
Fi:' Saes@ciberi pf Gl horvel@defr R \Write
gy Yahesal kall | waLr anrciment at GLE A kB message

[ Admeniira

! 5] Cleerii wﬁ

5 L0 R

'3 ,_E_T’E‘L___ for syne

Marking a folder for synchronisation means that all messages in that folder that have not been fully downloaded will be downloaded, within the message
component (header, body, attachment) and size limits defined for the account.
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Marking mail for download

Mail messages are marked for full download by selecting the associated mail header and either using the Mark for retrieval command button or using the
menu command Synchronise->Mark entry. Additional commands are also available for the unmarking of message headers, and the marking of all headers
in a folder. The message entry is marked with a blue download arrow to indicate that it is to be downloaded at the next connection time. This connection
can either be interactive via Active Mail or scheduled. See the screen shot below

keting Hﬂ.ﬁ.
relrie
S 5 Club Nokia <Soft._. Realice the full power of yoo., 24 kB ZT/03/02 S e
%ﬂ-; Micols Pollasin -, R yaur Software review, T kR 15,|'ﬂ3,|'|]2 ¥airke all
0 3 Steve Clack <edi... Re Active Desk coverage in. 3 k2 02/03/02
ﬂ =) Flnhfm Hanhaan...- RE: ."f.':ll-.ré' I:Ie.s.h 26 kB 2300202 T
Tl Sz Horis Raczynski ... Fe Licerse of ActiveDesk i ke 1902702
s Boris Raczynski .. fe: License of ActiveDesk 5 kA 19,0202
ﬂ AT i

Marking a header for download means that the full message is downloaded during the next connection to the associated mail service. No restrictions are
placed on the message.
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Interactive Synchronisation

Mail accounts can be synchronised interactively using the Active Mail interface. New mail can be downloaded to any number or all of the configured mail
accounts through one command. This creates great efficiency in the usage of the Communicator device.

The synchronisation command is issue through the Synchronise now command button or using the menu command Synchronise->Synchronise now menu
command. The user is then presented with a dialog similar to that below:

OK
031
all accounts
! Vahoo! Mail (Fasthail) 3y » |
; Yahoo! Mall (D1d)
H . I Cancel

From this dialog the accounts to be synchronised can be selected.
Synchronisation proceeds, executing the following steps:

= Retrieval of new message headers.

= Retrieval of message bodies (as configured).

= Synchronisation of mail folders.

= Download of mail messages marked for full retrieval.
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Account Management and Synchronisation Commands
Sort by:

Choose the sort criteria by which to view messages in the Active Mail browser through the View=>Sort by menu commands.
Sort order:

Choose the sort order by which to view messages in the Active Mail browser through the View=»Sort order menu commands.
Expand folder contents (Ctrl+T):

This command is valid in the browser view of Active Mail. It allows the user to switch between a folder / detail view of the mail accounts and a
message detail view.

Synchronise folder:

Marks the current folder to be synchronised.
Synchronise now (Ctrl+R):

Starts the interactive synchronisation process.
Synchronise all now (Ctrl+R):

Starts the interactive synchronisation process. This option does not prompt for the accounts to be synchronised, but synchronises all accounts by
default.

Synchronise settings (Ctrl+Y):

Opens the configuration dialog for the settings of the interactive synchronisation options. See Interactive Synchronisation Settings for more details.
Mark entry:

Marks the current message entry to be fully downloaded during the next connection to the associated mail account.
Show download report:

Select this option in the Tools menu to have Active Mail display the download report after a synchronisation operation (either interactive or
scheduled).
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Interactive Synchronisation Settings

The interactive mail account synchronisation process is controlled by the options defined in the Interactive Synchronisation Settings dialog. These options
are invoked either through the menu option Synchronise=» Synchronise settings or through the Ctrl+Y hotkey.

Use account
settings from

Select Yes to use the default account settings as defined in the built-in
Messaging Application. Selecting No will allow you to define the

General ]m"q | Messaging components of the message and the maximum message size to use
application: when interactively synchronising mail accounts.
Use account settings from > Ves y sy g
Messaging application Retrieve: Select the components of the messages to download when
riave synchronising a mail account interactively. Available options are ‘Mail
.- headers only’ and ‘Messages and attachments’.
Max. size of Set the maximum size of emails to download during the synchronisation
mail: in kB.
Play sound Select Yes to play a user definable new mail sound when a new mail
when new arrives. The particular sound and the volume are defined in the following
mail: fields.
Play sound when new mal = Yes Sound file The folder where the sound file is located.
Sound file folder » ...s\ActiveMall folder:
Sound file » NewMailwav Sound file: The sound file to be played when a new mail arrives. Currently only the
Volume » | NI wav file format is supported.
Volume: The volume at which to play the sound on a scale of 0 — 5.
02/09/2002 Page 11 of 32



Cibenix

Download Rules Settings

How Active Mail applies downloading rules to new emails is controlled by the options defined in the Download rules settings dialog. These options are
invoked either through the menu option Synchronise=»Download rules or through the Ctrl+D hotkey.

The dialog displayed provides a summary view of all the download rules defined. To view
and/or edit the details of a particular rule press the Edit command button. To create a new

ander Subject Aetive rule entry, press the New command button. Wildcards can be used as appropriate.
=u *@junkmai.com W Yas For details on the configuration options for a rule entry please see the New Download rule
— ” configuration section below.
> Firgmcial results® Yoz

Action Icon: Specifies the action to take if a match occurs. The download symbol
indicates the full message is downloaded while a wastebasket symbol
indicates the email will be deleted automatically.

Sender: Identifies the address of the sender of the email.
Subject: Identifies the subject line of the email.
Active: If Yes, the user has authorised the automatic download or delete as part

of the execution of this rule. If set to No the rule will not be used.

New Download Rule Configuration

An existing download rule can be edited, and a new rule can be created from the Download Rules settings dialog. The following describes the various
options available to the user to configure a new Active Mail download rule entry.

Please note some general points:
« All of the listed options are ANDed for a rule to be applied.
e Matching is not case sensitive.

* Wildcards can be used appropriately e.g. if you do not want to make use of a specific option, enter * in that field.
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If Sender »
and Subject w “letteryTresults”
=

and Priority
and masx. size of mail »
Then » Download

Medium

Sender:

Subject:

Priority:

Max. Size:

Action

Active

Enter the address that identifies the sender of the email. Use the Insert Mail
Address button to find an address in the Contacts database.

Note: The sender address is used for matching purposes and not the ‘friendly’
name. Example 1. If the email from address is

Support <support @i beni x. cone
Then support @i beni x. comshould be used in the rule.

Example 2: If you want to fully download all email from cibenix.com, you
should enter

*@i beni x. com
Enter the text that identifies the subject of the email.

Example: If you want to fully download all email with lottery results in the
subject (with any single character between the words), you need to enter

*|lottery?results*

This option specifies the priority of the email. Use * if you do not wish to use
priority when considering this rule.

This option specifies the maximum size of the email for the rule to be applied.
Use * if you do not wish to use size when considering this rule.

Specifies the action to take if a match occurs i.e. automatic download or
deletion if a match occurs.

If Yes, the user has authorised the automatic download or delete as part of
the execution of this rule. If set to No the rule will not be used.

02/09/2002
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Active Mail Scheduler

The Active Mail scheduler is the engine behind the application which allows virtually all mail operations to take place in unattended mode, allowing for
costly mail downloads to take place at off-peak hours.

The scheduler provides the full features of the interactive download, with the additional advantage that the operation can be scheduled to take place at any
time, including during off-peak hours where communications costs can be vastly reduced.

The Active Mail scheduler provides a number of additional controls specifically design around the management and control of unattended downloads. For
more details see Active Mail Scheduler Settings.

..!_ [=
F
@ Ratrieving marked mail for account GarryECibanix
BActive Mail Froceszng maszage Fof 1.
Schedulor [

& DETA ¢|

3 ICaibiad
hd W' & Exit

Once a scheduled event is detected, the synchronisation proceeds, executing the following the same steps as the interactive download, i.e.:
= Retrieval of new message headers.
= Retrieval of message bodies (as configured).
= Synchronisation of mail folders.

= Download of mail messages marked for full retrieval.
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Active Mail Scheduler Commands
Scheduler settings (Ctrl+S):

Opens the configuration dialog for the settings of the scheduled synchronisation options. See Active Mail Scheduler Settings for more detalils.
Scheduler log:

Opens the scheduler log.
Clear log:

Clears the scheduler log.
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Active Mail Scheduler Settings

The scheduled mail account synchronisation process is controlled by the options defined in the Message scheduler settings dialog. These options are
invoked either through the menu option Synchronise=»Scheduler settings or through the Ctrl+S hotkey.

Note: These settings are shared with the Active Desk Message Scheduler (except for the sound settings which are not supported in Active Desk). Active
Desk v1.60a or higher is required for compatibility with Active Mail.

i e ————— . | Schedule The Scheduler entries tab provides a summary view of all the schedules
AL = S entries tab: defined. To view and/or edit the details of a particular schedule press the
|Imhmula antries ]Smuuulr options .[Snl.lnd | Edit command button. To create a new schedule entry, press the New
I command button.
Account Active Fepeat Mext Eor detail H " ) ons f hedul |
- or details on the configuration options for a schedule entry please see
stal oMl e o BT e WL ) - New Active Mail Schedule Configuration below.
2. Carry@Cibarix a5 Every 1days 0730 15,04/02 ) ) ) )
Account: The email account associated with this schedule.
Active: If Yes, the user has authorised the automatic initiation of a call as part of
the execution of this schedule. If set to No the schedule will not run as a
call cannot be made to connect to the email service.
Repeat: A summary of the repeat information for the schedule.
Next: The date and time that the schedule will next run.
02/09/2002
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_mmammnraﬂﬂ

.q:ﬁmsl'[swnd ]

Log scheduled activity

= 156  secs before connaecting
= YES

= Documeants
= AD Schedulelag

[Smu-:lulu anfries rsnhudulu' options [Sumlﬂ
Play sound when new mail = Yes

Sound file falder = \System
Sound file » System.ini
Volume » [ ]I

Wait x secs
before

connecting:

Log
scheduled
activity:

Log folder:
Log file:

Work day
starts

Work day
starts

If phoneis
off:

Play sound
when new
mail:

Sound file
folder:

Sound file:

Volume:

The number of seconds that the Active Mail Scheduler will pause before
initiating the call to the email service. This can be used to provide the
user the opportunity to cancel the execution of the schedule (e.qg. if they
are using the Communicator for another purpose at the time).

If set to Yes, all scheduled operations will be logged to the file defined in
the following two fields.

The folder where the scheduler log file is stored.
The name of scheduler log file.

The time that defines the start of the work day. A schedule can be defined
to run during or outside work hours.

The time that defines the end of the work day.

You can define to cancel a scheduled email download or postpone it if the
phone is switched off. If cancelled, this instance of the schedule will be
ignored. If postponed, the schedule will run soon after the phone is
switched on again.

Select Yes to play a user definable new mail sound when a new mail
arrives. The particular sound and the volume are defined in the following
fields.

The folder where the sound file is located.

The sound file to be played when a new mail arrives. Currently only the
wav file format is supported.

The volume at which to play the sound on a scale of 0 — 5.

02/09/2002
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New Active Mail Schedule Configuration

An existing schedule can be edited, and new schedules can be created from the Schedule entries tab of the Message scheduler settings dialog. The
following describes the various options available to the user to configure a new Active Mail synchronisation schedule entry.

' General |Schedule |Retrieve |
Mail account| » GarryECibenix

Authorise auto dial = Mo
Send outgoing mail = Yes
Limit connect tima = No

Mail account:

Authorise
auto dial:

Send
outgoing
mail:

Limit
connection
time:

Connection
limit X mins

Retries:

The email account from which to retrieve the email. Both POP3 and
IMAP4 accounts are supported.

This option must be set to Yes for the schedule to run. The option is
required as the user must authorise Active Mail Scheduler to make a call
on the user’s behalf.

Whether to send outgoing mail associated with this account in the outbox
during the connection.

Set to Yes if you wish to limit the amount of time to stay connected to the
email service during the schedule execution.

The number of minutes to limit the connection. Only applicable if the ‘Limit
connection time’ option is set to Yes.

The number of times the Active Mail Scheduler will retry the operation if
an error should occur.

02/09/2002
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LA LA

[ B T

General | Schedule||Retrieve |

Schedule start » (3 10:6am [2- 14/04/2002
Repeats » Mo

r\.
r-\.

Schedule
start:

Repeats:

Repeats
every:

Repeat
forever:

End schedule
after x
occurrences:

Schedule
end:

Day
restrictions:

Time
restrictions:

The date and time at which the schedule will start. The operation is
guaranteed to start with 2 minutes of this time (but not before).

Defines if the schedule repeats.

Defines the repeat pattern for the schedule. The schedule can repeat by
minutes, hours, days, or weeks.

If set to Yes the schedule will repeat indefinitely, with no end date defined
until the user cancels the schedule or changes the repeat pattern.

If the schedule is configured not to repeat forever, this parameter defines
the number of times the schedule will execute.

If the schedule is configured not to repeat forever, this parameter defines
the date after which the schedule will no longer execute.

This can be set to one of the following options:

= None.

=  Work week only. The schedule will only run on week days.

=  Weekend only. The schedule will only run on weekend days.
Note: the work week is taken from the Communicator’s locale settings.
This can be set to one of the following options:

= None.
= Work hours only. The schedule will only during work hours.

= Qutside work hours only. The schedule will only outside of
working hours.

Note: the definition of work hours is taken from the Schedule options
defined in the Message settings dialog (see Error! Reference source not
found.).
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' General |

Fendat | BUE UL
Schedule Ratrieve| |

Retrieve » Mail headers only
r\.

Mowve or copy = Copy

Retrieve:

Max size of
email:

Move or
copy:

Defines whether to retrieve:

= Message headers only.
= Message bodies (only applicable for IMAPA4).
= Messages and attachments.

Defines the maximum size of email to download.

Defines whether to copy mail (i.e. leave a copy on the server) or to move
the mail to the Communicator (and delete from the server).
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Active Mail Notifications Manager

The Notifications manager allows you to set up rules on how to process new mail notifications that arrive via SMS. Active Mail can be configured to
automatically respond to an SMS notification, connect to the corresponding email account and download any new mails from that service.

Simple and Extended Notifications
Simple notifications come in two forms:
1. Ad-hoc format.

This is a non-standard format supported by many email service providers. These notifications typically include information such as the address of
the sender, and the subject line of message.

2. Nokia Smart Message format.

This standard defines that the notification takes a specific format which defines how many new messages are available in the associated mail
account.

Extended notifications are a Nokia Smart Message standard defining extended information related to new emails. This information includes the unique
identifier of the message, the sender, size, and subject line.

Notifications Commands
Notification rules (Ctrl+F):
Opens the configuration dialog to define the rules for managing notifications. See Notifications Settings for more details.
Disable notifications:
Temporarily disables the processing of all notifications.
Notifications log:

Opens the notifications log.
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Notifications Settings

How Active Mail processes SMS notifications of new emails is controlled by the options defined in the Mail notifications settings dialog. These options are
invoked either through the menu option Notifications=»Notification rules or through the Ctrl+F hotkey.

Simple |£ o0 o |Retrieve |Sound |

Agcount Motifier Ative
1, Barry@Cikenix S 3952 Yes
2. Bales@ECibenix fuleen heade LIH

| Simple tab:

Account:

Notifier:

Active:

|Slrl1|:le.]- Retrieve| | Sound |

Fetrieve » Messages and attachments
Pda. size of mail » 20 kB

Retrieve:

Max size of
email:

The Simple tab provides a summary view of all the simple notification
rules defined. To view and/or edit the details of a particular rule press the
Edit command button. To create a new rule entry, press the New
command button.

For details on the configuration options for a rule entry please see New
Simple Notification Configuration below.

The email account associated with this schedule.

Identifies the address of the sender of the notification. This can be either
a number of a name.

If Yes, the user has authorised the automatic initiation of a call as part of
the execution of this rule. If set to No the rule will not run as a call cannot
be made to connect to the email service.

Defines whether to retrieve:

= Message headers only.
= Messages and attachments.

Defines the maximum size of email to download when executing a
notification rule..
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71z | Retrieve | Sound||

Fay saund when new mail = Yes

Sound file folder » .. ments\Tones
sound file » Wamingwav
Valume » _|EINNIEN

Play sound
when new
mail:

Sound file
folder:

Sound file:

Volume:

Select Yes to play a user definable new mail sound when a new mail
arrives as part of a notification rule execution. The particular sound and
the volume are defined in the following fields.

The folder where the sound file is located.

The sound file to be played when a new mail arrives. Currently only the
wav file format is supported.

The volume at which to play the sound on a scale of 0 — 5.
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New Simple Notification Configuration

An existing simple notification rule can be edited, and new rule can be created from the Simple tab of the Mail notifications settings dialog. The following
describes the various options available to the user to configure a new Active Mail notification rule entry.

| General |Limits |Content |
Matifier number/name »

Mall account » GarryECibeni:
Authorize auto dial = Mo

l .-'! l.'! '.Slfllj.-]'! JI'.-'!“.'.!'.J.H’..-J!

Notifier
number /
name:

Enter the name or the number that identifies the sender of the
notification. Use the Browse Contacts button to find a number in the
Contacts database.

Note that in both the case of the name or number being used, a match
will be found if the data entered here is contained in the sender

information. So, for example, if the notification can come from +44 123
1234 or 0123 1234, then enter 123 1234 as this is the common part of

Supports Nokla Smart | .. the sender address. The more accurate the entry data can be, the less
chance there will be of a false natification.
Mail account:  The mail account from which mail will be retrieved when the notification
arrives.
Authorise This option must be set to Yes for the schedule to run. The option is
auto dial: required as the user must authorise Active Mail to make a call on the
user’s behalf.
Supports Set this option to Yes if the notification supports the simple notification
Nokia Smart standard as defined by Nokia.
Messaging . e )
standard: For example, if your notification is of the format:
/I MLAP11 or / [ SCKL1588
5 42
then your service supports the Nokia Smart Messaging Simple Email
Notification Standard.
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I ]':-' .r! 'Z-l..l.ll_l.-'l ! J!'J .! .lH!.! il !l '.-'ll

| General | Limits| |content |
Limit connections » Yes
Max connect avery » B
= Minutes
r|.

Limit
connections:

Max connect
every:

Only connect

Set this option to Yes to restrict how often notifications will cause Active
Mail to connect to the mail service. If set to No every email notification
will cause Active Mail to connect to the configured mail service.

Define the minimum time space between connections to the mail
service. For example, if the last connect was made at 9:30am and a new
notification arrives at 9:45am, if the settings opposite are active the next
connection will be made at 10:30am.

This option is only available is ‘Limit connections’ is set to Yes.

Define the minimum number of new messages which must be reported

if x or more before connecting to the mail service.
nmeg;sa es: This option is only available if your mail notification service supports the
ges: Nokia Smart Messaging Standard.
— : Always This option allows the connection restrictions described above to be
STl e connect if overridden. Set this option to Yes to force Active Mail to connect to the
[Gmmal ]LJmIl: [Euﬂtmt] rc]gggcir?g'on mail service if the defined text is present in the notification.
Always connect if ' For example, your notifications may contain sender addresses, or
notification contains| ™ Ves subject lines. The content of the notification can be searched to
Text1 » infovibenixcom determine if any of the key fields defined below are present in the
or Taxt2 = message.

Text 1-3: Three fields containing the text to be searched for. If any of the text
fields are found in the message, Active Mail will connect to the
associated mail service and download the new mails from that service.
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m-Mail

The m-Mail editor is a cost and time efficient mechanism for send emails quickly and cheaply — perfect for those urgent emails. It has a familiar interface
and allows emails to be sent over the SMS communications protocol, thus removing the need to even connect to an ISP.

What is m-Mail?

m-Malil is the ability to send emails quickly, easily and at low cost through a specially formatted SMS message. These SMS messages are sent for the cost
of a standard SMS messages to a special gateway provided by a service provider.

Your messaging service may already support m-Mail. Otherwise, the list below provides a small sample of the service providers who support m-Mail:

www.connectotel.com www.iobox.com, WWW.Ssonera.net

www.excell.to www.mobiili.net

The m-Mail Editor

The Active Mail m-Mail editor makes the sending of an m-Mail message as quick and easy as sending an SMS, and as powerful as sending an e-mail.
= Create m-Mails from the Active Desk and Active Mail interfaces, or by launching the editor independently (e.g. from Extras).
= Select the recipients list from the Contacts database.

= The m-Mail format and SMS gateway number is configurable to suit your m-Mail service. All common configuration options are supported.
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m-Mail Commands
The following commands are available from the m-Mail editor application.
Send (Ctrl+S):
Sends the current m-Mail message.
Close (Ctrl+E):
Closes the editor without sending the message.
Add to Desk:
A link to the m-Mail editor application can be added to Nokia 9200 Desk by selecting File=»Add to Desk from the m-Mail menu bar.
Cut (Ctrl+X):
Cuts the selected text to the clipboard.
Copy (Ctrl+C):
Copies the selected text to the clipboard.
Paste (Ctrl+V):
Pastes the current contents from the clipboard.
Select all (Ctrl+A):
Selects the entire contents of the current field.
m-Mail settings (Ctrl+M):
Opens the dialog through which m-Mail can be configured. See m-Mail Settings for more details.
Check names:
Checks the names in the To field, using the Contacts database.
Log (Shift+Ctrl+L):
The Nokia Communicator’s log application can be invoked by selecting Tools=»Log from the menu, or by using the hotkey Shift+Ctrl+L.
Receive via infrared:

Infrared reception can be activated through Tools=»Receive via infrared... from the menu, or by using the standard Chr+: shortcut.
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Help (Ctrl+H):

Context sensitive help on using m-Mail is available via the menu by using the command Info=»Help from the menu bar or the Ctrl+H hotkey. The
standard Nokia 9200 help button can also be used.

What is m-Mail?:
Information on m-Mail messaging is provided via the menu by using the command Info®What is m-Mail?
About m-Mail:

A standard About dialog is available via the menu by using the command Info=»About...
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m-Mail Settings

The Active Mail m-Mail editor provides a number of configuration options to allow you to defined exactly how the service is configured for your m-Mail
service provider. These options are invoked either through the menu option m-Mail<»m-Mail settings or through the Ctrl+M hotkey. The settings can also

be defined directly from the m-Mail editor interface.

Note: By default the m-Mail editor is configured to use the m-Mail gateway provided by www.connectotel.com. These settings can be easily over written to

use the gateway of your choice.

Service name:

Give a meaningful label to the service entry.

: SMS gateway  Enter the SMS destination number for your m-Mail service. Use the
General |Format ]l:ml.‘-ntmatlm | number: Browse Contacts button to select a number from the Contacts database.
Service name| » m-Mail Check with your service provider for the number of the m-Mail gateway.
EMS gateway number e 447747782320 . . . . ) . . -
gWarn l;&rsmdlng ! Warn if Set this option to Yes if you wish to be warned if sending the m-Mail will
. > Yes sending result in more than one SMS being sent.
multiple SM3 messages multiple SMS g
messages:
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VNGl e LI

General | Format || Concatenation |

Message format » <@TDE> («ESUBJECTE=)
<IEBODY G

Tand 'Ta" fiald oo onforod = K

| u;m-al [ qut ' Concatenation||

Gateway supports concatanatien » Yes
"Continug’ eharacter(s) » +
Terminate' character(s] »

Message
format:

Send ‘To’ field
as entered:

Gateway
supports

concatenation:

‘Continue’
character(s):

‘Terminate’
character(s):

Define the message format used by your m-Mail gateway. Use the Insert
recipient, Insert subject, and Insert body commands to insert the
placeholders for the To, Subject and Body fields of the format.

Check with your service provider for supported formats.

Set this option to Yes if you do not want the m-Mail editor to process the
To field of the entered message. If this option is selected the To field will
be copied into the ‘TO’ placeholder position with no processing (e.g. no
translation into email addresses, or creation of a separate message for
each entry in the To list.

This can be used if your m-Mail gateway supports additional features
such as cc fields

Set this option to Yes if your m-Mail gateway supports the ability to
concatenate a number of SMS messages into one email.

Check with your service provider if this feature is supported.

Enter the character that is to be appended to the end of an SMS
message to define to the gateway that the next SMS should be
appended to this one to create one email message.

Enter the character that is to be appended to the end of an SMS
message to define to the gateway that this is the last message
component of an email.
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Appendix A Active Mail Process Flow

The following diagram shows how the various options and rules described in this document interact and work together regardless of how a mail download

is triggered.
Manual Scheduled Triggered by
download download notification
Download of Co.nnect.to
mail can be mail service
triggered b
on%gof threg @ Refeshing the
inbox
Refresh downloads the
Inbox headers of all
new mails
The bodies and @
e ewmaare B
downloaded if they new mail
match the generic @
rules defined in the .
options settings The retrieval and
associated with the SERlE delete rules are
connection trigger iz executed against
the header
@ information to
determine if any
Download new mails should
Download all marked mail be deleted
marked emails
whether marked @
explicity by the Delete emails
user or implicitly Pelaie mal from server
via the rules whether deleted
explicity by the
@ user of implicitly
via the rules
Disconnect
from service
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Contact Information

For more information and support please use the following:
Website: http://www.cibenix.com/

Email: support@cibenix.com
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